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About FabFilter Twin 3
We launched FabFilter as a company in 2004 with a small blue synthesizer: FabFilter One.
It soon became famous for its
filter quality, which proved to be a firm base for many plug-ins to follow. Since that time, a lot has happened, and
although FabFilter established itself with professional mixing tools like Pro-Q and Pro-L, our love for synthesizers never
faded.

With FabFilter Twin 3, we've reinvented Twin and its workflow, while still staying true to what it has always been: an
awesome sounding virtual analog, subtractive synthesizer. With a fully
redesigned interface and new full-featured preset
browser, Twin has become much easier to use
and program. And the new FX section, filter options, arpeggiator and sound
improvements
open up a whole new world of possibilities. Let's dive in!

New in Twin 3

The first thing you will notice when you open Twin 3 is the brand-new look. The completely
redesigned interface makes
Twin 3 more pleasant and much more intuitive to work with. All the
goodness is still here of course, together with many
new features:

Fully redesigned, highly simplified interface, with
an easier workflow, including a new design of modulation sources
and floating slot panel
and FX panels.

Improved the oscillator and filter sound quality,
with built-in, analog-modelled drift.

Added an extra fourth oscillator.

Increased the maximum number of voices from 32 to 64.

Added a Per Oscillator polyphony mode, where
every note triggers a different oscillator.

Added two extra filters, so four available
in total.

Added new, vintage-sounding EQ-type filter shapes (bell,
shelf, notch) for every included filter style. With the
internal drive and non-linearities,
this results in truly unique filtering behavior, with lots of character, incomparable
to
usual, clean EQ filters. Filters can be created and deleted in the display, just like in
Pro-Q or Volcano 3.

Added 6 dB/oct filter slope option.

Introduced large Cutoff/Peak offset knobs, which
adjust all filters at once. Of course, these can be modulated as
well.

Introduced an FX section with 6 different effects:

Reverb: a lush, vintage reverb with time,
brightness and pre-delay settings

Delay: Extensive delay effect, with tempo
sync, filter section and more

Chorus: Smooth chorus with basic rate, depth
and delay settings

Phaser: Classic phaser/flanger with rate,
depth, feedback and shift options

Drive: Ranges from subtle saturation to over
the top amp-like distortion

Compressor: Customizable compression, from
smooth to aggressive

Introducing a full-featured preset browser,
with support for tags, favorites and easy searching and filtering.

Added an Arpeggiator, with host tempo sync,
groove/legato controls and transpose, note order and latch options.

Added optional High Quality mode, which turns on
4x oversampling.
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Introduced Source Level (-200% .. 200%) control
for XLFOs, EGs, EFs and MIDI Sources, which scales the output of
the source. Of course,
this can also be modulated.

Lowered minimum Envelope generator attack/decay and
release times. Also, EGs now have a curve slope
setting for
the different stages, opening up a much wider range of possible
shapes, from very snappy and aggressive to gentle
and smooth.

The EG Threshold parameters are now modulation targets. In addition, the incoming
signal level is displayed in a
meter around the Threshold knob, and it's now possible
to audition the external side chain input.

Added Transient mode for envelope followers, which turns
them into transient detectors.

Introducing Slider mode and a range
setting for XY controllers. In Slider mode, the XY controller only works in
vertical
direction, taking up much less space. The range setting toggles between bipolar (-1 to 1)
and unipolar (0 to
1) behavior.

Increased the number of XY controllers/sliders to 6.

Modulation sources can now be renamed to make
their use easier to understand.

Increased the maximum number of modulation
slots to 100.

The XLFO Balance and Frequency Offset parameters are now modulation targets.

XLFO MIDI triggering now offers a new Legato mode.

MIDI Sources now offer a Range option
(available for Velocity and KB Track input), which lets you choose between
Negative (-1..0),
Centered (-1..1) or Positive (0..1).

Added the ability to hide modulation sources
except for XY controllers and Sliders. This is often useful, since most
presets use
XLFOs, EFs, EGs and MIDI sources to create certain effects, which in turn can be
controlled by XY
controllers and sliders.

Native sustain pedal support.

The interface now supports resizing and
Full Screen mode.

The resize button in the bottom right corner of the interface now offers a
Scaling submenu, with options to
increase
or decrease the scale of the entire interface, e.g. 125%, 150%, etc.

New factory presets, smartly organized and
carefully designed.

Support for loading Twin 2 and Twin 1 presets.

Introduced support for Pro Tools hardware control surfaces.

FabFilter Twin 3 is available in VST, VST3, CLAP, AU (Audio Units) and AAX Native formats.

Windows requirements

Windows 11, 10, 8, 7 or Vista

64-bit or 32-bit

VST 2/3 or CLAP host, or Pro Tools

macOS requirements

macOS 10.13 or higher (64-bit only)

VST 2/3, AU or CLAP host, or Pro Tools

Intel or Apple Silicon processor

Next: Quick start

See Also
Using FabFilter Twin 3
Upgrading to Twin 3
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Quick start
The installer will copy the FabFilter Twin 3 plug-in into the common VST, VST 3, AU (macOS only)
and Pro Tools plug-in
folders on your computer. On macOS, the global plug-in folders in
/Library/Audio/Plug-Ins are used.

In most cases, your host will then recognize the plugin automatically. However, if the
instructions below do not work, see
Manual
installation instead.

Pro Tools
Create a new stereo instrument track and add FabFilter Twin 3 as the first insert.

Studio One
Click the '+' button next to the Inserts tab of an audio track, instrument track or bus and select 'FabFilter Twin 3'
from the drop-down menu.

Logic Pro
Create an Audio Instrument track in the arrange window and select FabFilter Twin 3 as the input
and choose a
preferred output. You will find FabFilter Twin 3 in the Audio Units ->
FabFilter section.

Ableton Live
In Session view, select the MIDI track you would like to place FabFilter Twin 3 on, for example by clicking the track
name. At the left top of Ableton Live's interface, click on the Plug-in Device Browser icon (third icon from the top).
From the plug-ins list, double-click FabFilter/FabFilter Twin 3, or drag it onto the track.

Cubase
Open the VST Instruments panel, click on an empty slot and select FabFilter Twin from the menu
that appears.
Right-click in the list of tracks and choose Add MIDI Track to create a new MIDI
track and assign it to the new
FabFilter Twin 3 instrument.

Next: FabFilter Twin 3 overview

See Also
Upgrading to Twin 3
Overview
Loading presets
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Overview
FabFilter Twin 3's interface is divided into multiple sections:

Oscillators
Twin 3 lets you add up to four oscillators on the fly. The oscillator settings can be easily
customized directly and the
produced wave form is visualized in the background.

Filter display
The filter display lets you create up to four different classic, non-linear, self-oscillating
filters, which can be either
low/high pass, band pass, bell, low/high shelf or notch.
See Filters.

Main EG
Centered in the interface, the large ADSR envelope generator lets you easily customize the main
envelope of the
produced sound.

FX section
Twin 3 offers six out-of-the-box effects, which can be easily enabled and controlled via
the FX section at the right of
the interace. Clicking on the Amount knob will open up
a panel of options for each effect except Drive. See FX
section.

Modulation section
The modulation section at the bottom shows all modulation sources, visualizing the signal
flow and making it easy to
set up modulation and create new sources. FabFilter Twin 3
offers XLFO, envelope generator (EG), envelope follower
(EF), MIDI and XY controller or slider sources.
See Modulation to get started.

Piano keyboard
The Piano Keyboard button shows or hides the piano keyboard underneath the modulation section. It visualizes
incoming MIDI notes and you can click keys to play notes manually.

Arpeggiator
The arpeggiator button opens a panel with option to enable and customize the internal arpeggiator.

High Quality
The High Quality button controls the oversampling of the internal algorithms. See
Output controls.

Polyphony / unison
The Polyphony button gives access to polyphony, unison settings and microtuning. See
Polyphony, unison and
microtuning.

Output options
On the far right of the bottom bar, the output button gives access to stereo width,
output level and panning controls.
See
Output controls.

Full Screen mode, resizing and scaling
The Resize button at the far right of the bottom bar lets you change the interface size and scaling.
In addition, click
the Full Screen button in the top-right corner of the interface to let Twin 3
fill the entire screen. See Full Screen
mode, resizing and
scaling.
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MIDI learn
MIDI Learn lets you easily associate any MIDI controller with any plug-in parameter. See
MIDI Learn.

Presets, undo, A/B, help
With the preset buttons, you can easily browse through the factory presets or save your own
settings so you can re-
use them in other songs. The Undo, Redo, A/B and Copy buttons at the top
of the plug-in interface enable you to
undo your changes and switch between different states of
the plug-in. Finally, the Help menu provides access to help
and version information. See
Loading presets and Undo,
redo, A/B switch.

Next: Knobs

See Also
About FabFilter Twin 3
Support
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Knobs
It is easy to control FabFilter Twin 3's parameters with the large round knobs. They will light up when you move the mouse
cursor around to indicate that you can adjust them. The moment you move the mouse cursor over a knob, a parameter
value display will pop up, which shows the name and the current value of the parameter.

Most knobs support four ways of control:

1. Vertical mode
Click on the center area of a knob and drag up or down to rotate it. The knob reacts to the
speed with which you
are dragging, so if you move the mouse slowly, you make precise
adjustments.

2. Rotate mode
Grab the arrow of the knob and drag it around. By moving the mouse cursor further away from the
knob while
dragging it, you can make precise adjustments.
Some knobs show their position using a colored arc instead of an
arrow: these do not support rotate mode.

3. Mouse wheel mode
Perhaps the easiest way to make adjustments is by using the mouse wheel when you hover over a
knob. This
mode works for all the knobs and possible panning rings. (On Windows, you might need
to click in the plug-in
interface first to make sure it is the active window.)

4. Text entry mode
Double-click a knob to enter an exact value using the keyboard.

Tips

To reset a knob to its default position, hold down the Ctrl key (Windows) or
Command key (macOS) and click the
knob once. Note: In Pro Tools, Twin 3 uses the
default Pro Tools keyboard shortcut for reset: Alt+click.

To fine-tune a value when using vertical drag mode or the mouse wheel, hold down the
Shift key while dragging or
moving the mouse wheel. Note: In Pro Tools, Twin 3 uses the default Pro Tools keyboard shortcut for fine tune:
Ctrl+drag on Windows or
Command+drag on macOS.

There are several handy shortcuts in text entry mode. With frequency values, you can
type e.g. '1k' to set the
value to 1000 Hz, and also 'A4' for 440 Hz, or even strings like
'C#3+13'. With dB values, you can type e.g. '2x' to
get +6 dB (the value that corresponds to
two times louder). With all values, you can also type a percentage (e.g.
'50%' will put a knob
exactly in the middle position).

Sometimes, knobs in our plug-in interfaces are linked: these can be adjusted
simultaneously by holding down the
Alt key (Shift key in Pro Tools) while
dragging on one of them. For example, an output level and input level setting of
a plug-in
could be adjusted simultaneously (in the opposite direction) this way.

Next: Oscillators

See Also
Using on iOS
Support
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Oscillators

In Twin 3, you can use up to four full-featured oscillators. Combined with our award-winning
filters and the new FX
section, this gives you an exceptional broad palette of sounds. The
oscillators are vintage-sounding, and have built-in
analog drift: there is a very subtle randomness in various parts of the synthesizer, like the oscillator tuning and phase.

To add an oscillator, click the + button at the bottom of the oscillators. To delete one, hover over the oscillator and click
the small x button in the top-right corner.

Every oscillator can be easily customized and shows the produced waveform in the background. The following parameters
are available:

Waveform
The Waveform button selects the waveform that the oscillator produces:

Sawtooth: a sharp bright tone that is ideal for filtering

Square: a more metallic but still vintage and 'round' sound, adjustable with the pulse width setting

Square Pure: a more pure, digital square wave, also adjustable with pulse width setting

Triangle: a soft, warm tone

Triangle Pure: a pure triangle wave with more harmonics

Sine: a simple, pure sine wave, the most basic waveform without harmonics

White noise: has a flat frequency response, meaning all frequencies at equal power

Pink noise: like white noise but with less power in the higher frequencies

Enable
This will turn an oscillator on or off, so you can easily check the contribution of an
oscillator to the overall sound.

Pulse Width
The Pulse Width knob adjusts the pulse width of the square waveform, from an even square to
an infinitely thin
pulse (which is actually inaudible). Pulse width is a modulation
target and is only available when the Square or
Square Pure wave form is selected.

Detune
The Detune knob sets the detune for each oscillator. It has a range of +/- one
octave, and is extra sensitive around
the 0 position. It is a modulation target as well. Like
any other knob, you can double-click it to enter a value directly
using the keyboard. For
example, try '0.5 octaves' or '1 semitone' or '50 cents'. See Knobs
for more information.

Scale
Each oscillator can be transposed up to 3 octaves above and one octave below the
master tune.

Sync
The Sync knob adjusts the level of hard sync for its oscillator. When set to 1, the
oscillator works normally without
hard sync. When set to a higher value, the oscillator will
'squeeze' more phases into one actual audible phase, which
drastically changes the harmonics
in the sound with a metallic-sounding effect. Sync is a modulation target.

Phase Sync
Below the Sync knob, the Phase Sync button (with a MIDI icon) toggles oscillator
phase sync on and off. When
oscillator phase sync is on, the oscillator resets its phase to
halfway the waveform on each note-on event. With
short, percussive sounds, this works really
well to create a sharp and aggressive attack with every note. However,
normally you should
turn it off because it sometimes introduces unwanted clicks.

Level/Pan
The volume and pan of each oscillator can be adjusted using the combined Level/Pan knobs. The
inner knob set the
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overall level and outer ring sets the panning. Both are modulation
targets.

Ring modulation

You can enable ring modulation between two oscillators with the small
* button between the sections for oscillator 1 and 2
or oscillator 3 and 4. Ring modulation multiplies two waveforms, and outputs the sum and difference of the frequencies
present in each waveform. This produces a signal rich in overtones, suitable for producing bell-like or otherwise metallic
sounds.

Master Tune/Scale and Portamento

The Master Tune knob determines the global frequency offset of all oscillators. The Scale menu above the knob
transposes the frequency by full octaves. The Master Tune knob is a modulation target so you can modulate the frequency
of all oscillators at once.

The Portamento knob adjusts the amount of portamento or glide, which makes the oscillators
slide from one note to
another. A little portamento is great for smooth keyboard solos, or
when playing large bass intervals. Good portamento is
one of those things that give your play
just that little bit extra: it's magic. So we have fine-tuned it until it was just
perfect!
The best thing is: we have created a unique portamento because it also works in polyphonic
mode, so you can
play sliding chords. Normally, portamento is always applied, but when the
Portamento Legato button below the knob is
active, gliding will not be applied for the first key pressed, only for the keys after that. Portamento is also a modulation
target.

Tips

Modulate the Pulse Width knob with an XLFO for the classic pulse width modulation sound.

Using less oscillators reduces CPU usage. Also, the oscillators operate more efficiently
when the Sync knob is set to 1
and is not modulated (disabling hard sync).

When you want to change any oscillator parameter for all oscillators at the same time,
just hold down the Alt key
(Shift key in Pro Tools) while turning a knob.

Next: Filters

See Also
Overview
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Filters
The interactive filter display at the center of the interface lets you add up to four
high-quality, analog-like, self-oscillating
filters, full of character and with internal
saturation. The thick yellow curve shows the overall frequency response of the
filters.
All filter parameters can be easily controlled via the display, either by clicking and
dragging, or via the parameter
value display. Here's how it works.

Creating filters

To add a new filter, simply click on the yellow overall curve and drag it up or down.

Alternatively, double-click or Ctrl-click (Command-click on macOS) on the display
background.

The shape of newly created curves is determined automatically depending on where you click
or drag, and once you get
used to this, it's a real time-saver! Do you need a notch? Just
double-click in the far low area of the display. Want a high-
or a low-pass filter? Just drag the curve in the left or right
part of the display. Of course, you can also set the shape via
the parameter value display. The
available shapes are: Low/High Pass, Band Pass, Bell, Low/High Shelf and Notch. The
slope can
be set to 6dB, 12 dB, 24dB or 48 dB/oct.

Selecting filters

Click the filter's dot or the colored area near it to select it.

Click and drag on the display background to select adjacent filters by
dragging a rectangle around them.

Hold down Ctrl (Command on macOS) and click another dot to
select multiple filters. Hold down Shift and click a
dot to
select a consecutive range of filters.

Adjusting and editing filters

Once you have selected one or more filters, the display highlights the shapes of the selected
curves. You can easily make
adjustments by simply dragging them around:

Click and drag a selected dot to adjust the frequency and
peak of all selected filters. If you have multiple bell or
shelf
filters selected, the peak of all selected filters will be scaled relative to
each other.

Move the mouse wheel to adjust the slope of filters, making the selected filters
narrower or wider. This works while
dragging or when the mouse pointer is above a curve.
Alternatively, adjust the slope of all selected filters by holding
down Ctrl (Cmd on macOS) while dragging vertically.

Move the mouse wheel while holding down Ctrl (Cmd on macOS) to adjust
the peak.

Hold down Ctrl (Cmd on macOS) and drag horizontally to adjust
frequency panning of the selected filters. Filter
panning lets you filter the left and right
channels differently. It works as a stereo balance setting for the center
frequency of the
filter. For example, when you set panning to a negative value, the left channel will
be filtered with a
lower center frequency, and the right channel will be filtered with
a higher center frequency. You can use this to
create various stereo filtering effects,
especially in combination with modulation.

Hold down Shift while dragging (or while using the mouse wheel) to fine-tune
the settings of the selected filters.

Hold down Alt while dragging to constrain to horizontal
adjustments (frequency) or vertical adjustments (gain).

Hold down Alt and click the dot on a filter once to toggle its
bypass state (enabling or disabling the filter).

Hold down Ctrl+Alt (Cmd+Alt on macOS) and click the dot on a
filter once to change its shape.

Hold down Alt+Shift and click the dot on a filter once to change its
slope.

Double-click a dot to enter values in the parameter display (using
the Tab key to step through Frequency, Peak
and Pan) or double-click the values
in the parameter value display directly. Note that you can enter frequencies in
various ways,
like "100", "2k", "A4" or "C#2+13".

If you right-click on the dot for a filter, a pop-up menu appears with
various filter settings. This is a quick way to
modify the filter while you're working in the
display.

Frequency Offset and Peak Offset knobs

At the right of the filter display, two large knobs let you offset the frequency and
peak of all filters at once, which quickly
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adjusts the sound for any preset you load. And of course, these
can be modulated as well.

Filter parameter display

Next to each filter's dot in the display, the parameter display shows the exact parameter
values for the filter. By default, it
only shows the frequency (to save space and make it easier to
select multiple filters) but when you hover above it, it
extends and lets you control all the
filter parameters. You can easily bypass or delete filters
or change the shape, slope
or style. You can double-click the values
in the display directly to edit them.

Most of the filter parameters (frequency, peak, panning), can be modulated. Just drag a source to a line in the parameter
value display or to the filter dot
directly (to modulate the frequency). If multiple filters are selected, a slot will be added
for
each filter, so you can easily setup modulation for multiple filters at once.

Filter Styles

FabFilter Twin 3 lets you choose between 11 different filter styles:

FabFilter One, the original filter characteristic taken from our award-winning
FabFilter One synthesizer

Smooth, like the cream in your coffee

Raw, a filter with lots of overdrive and exhibits a character of its own

Hard, moderately distorting filter, with a nice clean whistle

Hollow, juicy moderate distortion with fairly much low-end self-oscillation

Extreme, for more wild sonic ideas

Gentle, a more smooth and clean general purpose characteristic

Tube, with a warmer sound and nice overdrive, great for synth sounds

Metal, with a rough, sharper sound and distortion

Easy Going, a softer version of the Tube filter

Clean, linear behavior with no clipping or distortion at all

Filter Routing

Use the Filter Routing button at the right, above the frequency/peak offset knobs, to change the routing of the filters.
There are three different setups:

Serial: the sound passes through both filters serially. So the sound of all oscillators
are led through filter 1 and then
through filter 2

Parallel: the sound is led through both filters in parallel and the result is then
mixed together after the filters

Per Oscillator: the output of oscillator 1 goes through filter 1, the
output of oscillator 2 goes through filter 2, etc

Tips

When filter modulation is taking place, the display will show the modulated result curve as a thin yellow curve
that
gets fuzzy for quick modulation.

If filter panning is in effect, additional result curves will show the overall filtering curve for each
channel (white for
left, red for right).

Next: FX Section

See Also
Oscillators
Modulation
Overview
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FX section
At the top right of the interface, Twin 3 features six high-quality, ready-to-use effect
units, from lush, vintage reverb to
heavy amp distortion. All effects have a distinct set of
controls, and of course, everything can be modulated.

For each effect, you'll see a large Amount knob, and an Enable/Disable button.
The menu button 
to the right of an
effect label gives access to presets per effect. Clicking in the
center of the knobs will open a panel with options per
effect. While dragging
to create modulation connections, you can hover above the knobs to open the panels.

Reverb

The vintage-sounding reverb unit has just a few controls, yet produces
a wide palette of sounds. Using the Time knob you
can set the decay time of the
reverb between 200 milliseconds (very small room) and 20 seconds (cathedral). The
Brightness knob changes the character from very dark, to shimmering bright. The
Predelay slider sets the initial delay of
the reverb, which can enhance the sense of
space. Modulating Predelay will introduce analog-style tape pitch modulation,
which
can be used to make the reverb more chorus-like.

Delay

The delay unit offers a stereo delay line with delay time panning and
feedback, combined with up to four multimode
filters. These have the same
specs as the synth's main filter, and can be added on the fly via the delay's filter
display. See
Filters for more information on the filter display.
Of course, the delay time can be synched to host tempo, and ping
pong modes
are also available.
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Chorus

The Chorus unit can be used to add subtle stereo widening, implemented using slowly
modulated delay lines. When
Chorus Mode is set to Single, only one tap per
channel is used, while Double uses two taps per channel, for a slightly
richer sound.
The modulation rate, depth and total delay range can of course
be customized.

Phaser / Flanger

The classic phaser unit adds swirling phase modulation using a series of allpass
filters with customizable modulation rate,
depth and feedback.
Higher rate or depth will make the effect more obvious while adding feedback will
make it more
pronounced.

When set to flanger mode, modulation is applied to a short delay line instead of
allpass filtering, similar to a chorus but
using much shorter delays and including
feedback, which makes the effect more like a phaser: both create notch effects in
your audio, but achieve this in a different way.

Using the shift slider, you can offset the phase of applied modulation in the
left and right channels, which makes the effect
sound wider.

Drive

The one-knob Drive effect applies subtle to modest saturation in the lower half of
the knob range, to obvious drive and
screaming amp distortion in the upper half.
Using the routing button at the right bottom of the knob, you can choose to
route the drive before all other effects, or after all effects (and just before the
final compression effect).

Compressor

The compressor is the final effect unit in the chain. With customizable threshold
and attack and release ranging from
very fast to subtly slow, it can be either
used to keep the output level under control, or to apply creative compression
effects like
pumping, etc.

When auto gain is enabled, automatic make-up gain is applied to the processed signal,
depending on current settings for
Threshold and Attack. Auto Gain helps you to keep the
audible audio level the same while adjusting the controls.

The output and gain change level meters, as well as the input meter around the threshold
knob, will help you to dial in
the right values.
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Tips

Most of the FX controls can be modulated. Try it!

Next: Modulation

See Also
Filters
Overview
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Modulation
When you open the plug-in with its default settings, the interface looks simple and clean. But the real fun with FabFilter
Twin 3 starts with the incredible modulation options. Almost any
parameter can be modulated. These are called
modulation targets. They can be
modulated by any of the following available modulation sources:

The XLFO can generate almost any waveform you can imagine and can be synchronized to the host tempo.

The Envelope generator is of the usual ADSR kind and
triggered by audio or MIDI.

The Envelope follower will follow the
loudness or transients of the audio signal it triggers on.

The MIDI source transforms any incoming MIDI data into a modulation signal.

Finally, the XY controller or slider lets you modulate targets using horizontal and/and vertical mouse movements.

To add a modulation source, just click the '+' button
in the modulation section at the bottom of the interface and
choose one of the available options.
Now, a source component button becomes visible,
showing a graphical
representation of the source's current settings.

To delete a source, move the mouse over the source component button and click the remove icon  in the right-top
corner.

Using the show/hide modulation button at the right of the + button, you can show or hide all modulation sources
except for sliders and XY controllers. This makes it easier to interpret and work with the various factory presets, which
often use quite a few XLFOs, EGs and EFs to achieve certain effects, and offer sliders or XY controllers to control the
amount of these effects.

A modulation source drag button is located at the top of the source (two for XY controllers). Drag-and-drop this button
to any modulation target in the interface to make a new modulation connection. The modulation signal always flows via a
modulation slot that allows you to vary the extent of modulation. Click the source drag button once to pop up the
modulation slot panel, containing all slots that are affected (either directly or indirectly) by this source.

A source level control, around the source drag buttons, is available for XLFOs,
EGs, EFs and MIDI Sources. This scales
the output level of the source. By default, this is set to
1, but it can be anything between -2 and 2. And of course, the
source level can also be
modulated.

Every source has its own associated color scheme, which is also used for
modulation visualization and modulation
indicators in the interface, making it easy to see which types of sources are modulating a target.

Click a source component button once to expand the full source interface. Click and drag a button to directly adjust the
main parameters for the source, as shown in the value displays when you hover above the button. For example, with an
XLFO you can directly change the frequency.

You can customize any source's name by double-clicking the label below
the source. Source names are stored in
presets, A/B and undo states and will be saved with your session.

Right next to the source name label, the preset button  provides access to the source's section presets. You can
customize the default settings for a newly added source by overwriting the predefined Default section preset using the
Save As Default item in the preset menu.
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Tip

When the plug-in first starts up, the modulation sources are hidden, except for the XY controller or slider sources, to
keep the interface as uncluttered as possible. Simply click on the >> button in the modulation section to show all
sources, and click on the << button to hide them again.

If a modulation source drag button shows a filled dot inside, this means the source is actually in use at the moment.

By default, if you expand a source to see its full interface, all other sources are collapsed to save space. If you would
like to keep them expanded, click the large + button in the modulation section, and
uncheck the Auto-Collapse
Sources option at the end. You can always collapse a source by clicking its << button,
or click on the background
between the sources to collapse all sources.

Next: Drag-and-drop modulation slots

See Also
Overview
Modulation visualization
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Drag-and-drop modulation slots
One of the best features in FabFilter Twin 3 is the way you set up modulation
connections with drag-and-drop. There is no
need to search through long drop-down menus
containing dozens of sources and targets or to find your way in cluttered
and obscure matrix
views. This simple method of making modulation connections makes sound design fun, easy
and,
above all: fast. So how does it work?

Grab a source... ... drag it to a target... ... and drop it.

First, grab the source drag
button that you would
like to use
as a modulation signal, for example
XLFO 1. The moment you click on
the source
drag button, the
interface dims and all modulation
targets are highlighted.

The moment you start dragging,
you will see a line from the source
drag button to the
icon that you are
dragging. If you hover the mouse
over the bands in the display or
source
selection buttons they will
automatically be activated. The line
will snap to any
available
modulation target.

Now drop the icon on the
highlighted target of the
parameter that you would like to
modulate, for example the Filter
Frequency knob.
That's all there is
to it!

After you have connected a modulation source to a target, the modulation slot panel will popup near the target control.
It contains all slots that affect the modulation target. Slots that modulate other slot levels, are shown indented and
connected to
the slot they are modulating.

When a control is modulated, a small modulation indicator dot appears near the control. The color matches the source
that modules the control. If multiple types of sources modulation a control, the modulation indicator consists of multiple
colored dots.

You can view the slots for a specific source or target, simply by clicking any of the modulation source drag buttons or
clicking any target control or modulation indicator in the interface. In the modulation slot panel that pops up, slots can be
adjusted in the following way:

Use the level slider to adjust the amount of modulation. Like with knobs, hold down Shift for fine-tuning; hold down
Alt to
adjust all slot levels for the same source; Ctrl-click (Windows) or
Command-click (macOS) to reset the level to
the default value. (In Pro Tools, the
default Pro Tools shortcuts are used instead.)

To the left of the Level slider, you can invert the modulation signal with the +/- button.

When you hover over the slider on the left an on/off button appears. Use this to
temporarily disable the slot.
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On the right, a drop-down menu is accessible that lets you change the
slot's source or target.

To delete the slot, click the Remove button  to the right of the Level slider.

To delete/bypass/invert all slots, use the drop down menu at the right top of
the slot panel.

Tips

When a modulation indicator appears next to the filter display or e.g. in an envelope generator, this means one or
more parameters of that filter or EG are modulated. When you click the indicator, the modulation slot panel that
pops up shows all slots that modulate the filter or envelope generator.

To hide the modulation slot panel, simply click on a background area in the display or interface.

Next: Modulation visualization

See Also
Modulation
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Modulation visualization
FabFilter Twin 3 contains advanced modulation visualization features which greatly help you
to understand the effect of the modulation that is
going on. In the plug-in interface, modulation is visualized
in three different ways: the effect of applied modulation to controls is shown by real-
time target level indicators, the global amount and direction of modulation generated by sources is visualized in the
source flow area, and
finally, current connections by different types of sources are
made clear by the modulation indicators next to target controls.

Target level indicators

All modulation that is applied to a control in the interface is shown in real-time via target level indicators
around knobs, sliders and other controls.
The level indicator originates from the current knob/slider position, and shows the range of modulation: it visualizes how the knob is dynamically
changing due to the current modulation signal.

The color of the target level visualization matches the type of source that modulates it. Note that
if a target is modulated by multiple types of
sources, a generic yellow color is
used instead.

The source flow area

In the area right above the modulation sources, the signal being produced by the sources is visualized in
real-time by a diffuse flow, directed
towards the targets it is currently modulating.
This visualization gives you a global idea of the current activity and effect of sources. It is not
intended
to show all connections exactly, as this would highly clutter the interface and would probably be more confusing than helpful.

Modulation indicators

When a control is modulated, a small modulation indicator dot appears near the control. The color matches the source that modules the control. If
multiple types of sources modulation a control, the modulation indicator consists of multiple colored dots.

When a modulation indicator appears in the filter display or in an envelope generator, this means one or more parameters are modulated. When
you click the indicator, the modulation slot panel that pops up shows all slots that modulate one of these targets.

Tips

Click on a modulation indicator next to a target control or on a control itself, to pop up the modulation slot panel, showing all associated
modulation slots. Click the control again, or click on the interface background, to hide the modulation slot panel.

Are you seeing yellow colored target level visualization? This means that the target is modulated by multiple types of sources at the same
time.

In case you find the source flow visualization distracting, click the large + button in the modulation section, and
uncheck the Show Source
Flow option at the end to turn it off.

Next: XLFO

See Also
Overview
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XLFO
The XLFO is like a classic LFO (Low Frequency Oscillator) on steroids: it can do so much more! It can be a regular LFO, but
it can also turn into a 16-step sequencer with an individual glide setting for every step. The display shows the waveform
that is used by the XLFO. Steps can be freely added or deleted to shape the funkiest of waveforms.

To add an XLFO as a modulation source, click the + button in the modulation section and click New XLFO.

Initially the XLFO is shown as a source component button in the interface, showing a graphical representation of the
current settings. For more information on working
with source component buttons, see Modulation.

Click the source component button once to expand the full XLFO interface:

At the left, you will find the global parameters that affect the entire
waveform:

Frequency
The frequency knob sets the time it takes for one cycle of the waveform to complete. This
knob is a modulation
target, so you could let one XLFO modulate the frequency of another
XLFO. The XLFO can be synchronized to the
tempo of the plug-in host or set to run free. With
the options at the top-right corner of the frequency button you can
choose the different
settings:

Free running mode will allow values from 0.02 to 500 Hz, so the minimum cycle length is
0.002 seconds.

When using any of the synchronized cycle lengths (16 to 1/64, measured in bars) the
frequency knob changes
into the Offset knob. It now acts like a cycle
length multiplier and therefore is capable of changing the cycle
length relative to the
host tempo, from half to two times the host tempo. Click the dots around the knob to
jump
to certain predefined offsets for dotted and triplet synchronization. Note that the Offset knob is also a
modulation target.

Balance
The outer ring of the frequency knob adjusts the time balance of the first and last halves of
the step sequence. For
example, when turned to the left, the first half of the wave form is
generated more quickly than the last half. The
balance ring is also a modulation target so you can modulate the balance for creative effects.

MIDI sync
The XLFO can be restarted at any point using MIDI if one of the MIDI sync options is enabled at the top-right corner
of the frequency knob. In the Retrigger mode, any note-on MIDI message (e.g. pressing a key) will restart the cycle
of the waveform (to the point set by the Phase offset slider). If set to Legato mode, the XLFO will only be
triggered
by the first note-on MIDI message, and won't retrigger on successive notes
while notes are still being held down.

Snap
This function makes it possible to use the XLFO as an arpeggiator. When you enable Snap, a
small piano keyboard
appears, the range of the XLFO turns into 2 octaves, and steps "snap" to
notes on the piano keyboard. Now when
you modulate a frequency parameter, turn the slot level
to maximum, and the total amount of modulation will
exactly correspond to 2 octaves.

Glide
The global Glide knob acts like an overall glide offset. The amount of glide determines the
point within a step at
which the XLFO starts to interpolate to the value of the next step.
The global Glide value is added to the glide value
for individual steps to arrive at the
final glide value for each step. The final glide value is limited between 0 (no
interpolation) and 1 (full interpolation). Because the global Glide value can range from -1
to 1 it can completely
overrule the individual step glide values at the extreme settings. It
is also a modulation target which allows for very
cool effects.

Phase offset
In the step editor you can see a triangular shape. The vertical line of the shape indicates
the beginning of each cycle.
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You can move this triangular shape, and thus change the
beginning of a XLFO cycle. This phase offset is a
modulation target, so when the XLFO
frequency is set to 0, you can use another modulator to cycle through the
different
steps. Tip: Like with knobs, you can
Ctrl/Command-click on the phase offset slider to reset it.

To delete an XLFO, move the mouse over it and click the remove button  in the top right corner. Below the source, next
to the source name, the Presets button  provides access to the XLFO section presets. By default, the XLFO
starts with two
steps that make a sine wave. You can customize this by overwriting the predefined
Default section preset using the Save
As Default command from the preset menu.

Editing Steps

You can shape the waveform of the XLFO in almost any way you want by editing the individual
steps.

Drag a step up or down to change the value for the step.

Click a step to select it.

Hold down Ctrl (Command on Mac) and click a step to select
multiple steps. Hold down Shift and click a step to
select a
consecutive range of steps.

Click next to a step to deselect all steps.

Click the + button at the end of all steps to add a new
step. The new step is added to the right of the selected step,
or at the end of all steps.

Click the - button at the end of all steps to remove the
selected steps. If no steps are selected, the last step is
removed.

If one or more steps are selected, the XLFO expands to show the step
interface where the parameters for the selected
steps can be edited:

Random
The Random button enables random values for this step. If
enabled, the XLFO will use a new random value for the
step each time it encounters it. The
display also changes to show that the value is chosen at random (see step 3 in
the screen shot
above).

Value
The Value knob adjusts the value of step. This is the same as dragging the step up and
down, except that with
multiple selected steps, the value of all steps is set to the same
value. In contrast, when you drag multiple selected
steps, the relative distance is kept the
same.

Curve
The Curve button selects the curve that is used to interpolate to the next step when the final
glide value is higher
than 0: Linear, Sqr, Sqrt and Sine.

Glide
The Glide knob sets the per-step glide value. This is combined with the global glide value
to determine at which point
the XLFO starts to interpolate towards the next step.

To start exploring the many sound-shaping possibilities, start with an XLFO that modulates the Filter Frequency knob to
make the sound change
over time. You'll be amazed by the many possibilities. Have a look at the presets to see the XLFO
in many different setups to get an idea of what it can do for you and start creating your own
sequences!

Next: Envelope generator

See Also
Modulation
Drag-and-drop modulation slots
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Envelope generator
The envelope generator (EG) generates a traditional ADSR envelope. The envelope defines how the level changes with
time and is controlled by the Attack, Decay,
Sustain and Release parameters. Its function is to modulate a parameter over
time,
based on MIDI input or the amplitude of an audio signal that triggers it.

To add an envelope generator as a modulation source, click the + button in the modulation section and click New
Envelope Generator.

Initially the EG is shown as a source component button in the interface, showing a graphical representation of the
current settings. For more information on working
with source component buttons, see Modulation.

Click the source component button once to expand the full EG interface:

The expanded interface contains a large graphical envelope controller with triggering controls on the left.

The trigger input button opens a menu to select which signal is used for triggering the EG: the signal from the
external side-chain input,
or MIDI note on events. See also External side chaining.

An audition button becomes visible when triggering on the external side-chain. Click and hold it to temporarily listen
to the signal this EG is triggering on.

The threshold knob sets the level of the incoming signal that the EG
will trigger on. You should adjust the threshold
depending on the type and amplitude of the incoming signal. The circular level meter around the threshold knob
gives a good indication of what threshold level to use. Note: the threshold knob is hidden when MIDI input triggering
is used.

The range button selects whether the EG produces a signal in the default range between 0 and 1, or with a range
such that the EG outputs 0 while
in its sustain phase. In the latter case, the EG will attack from a negative value to a
positive value, and finally release to a negative value. This "centers" the output value around 0, which can be useful
for modulation.

In the envelope controller you can click and drag the dots to customize
the envelope shape. The following parameters
are available:

Delay
The time it takes for the attack to start after the key is pressed (or triggered when the
input signal exceeds the
threshold).

Attack
The Attack portion of the envelope is the time taken for the amplitude to reach maximum
value. Slow attack is
commonly part of sounds called pads. But for percussive sounds the
attack time should be as short as possible.

Decay
After the sound has reached its maximum level, it starts to decay until it reaches a level
known as the Sustain level
at a rate set by the Decay time setting.

Sustain
This is the level reached after the decay time. The EG will hold this level as long as a key
is pressed (or as long as
the trigger input level is above the threshold). Note that this parameter specifies a volume level rather than a time
period.

Hold
Once the key is released (or the input level drops below the threshold), the value will remain
at the sustain level for
a time set by the hold parameter.
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Release
After the hold time the sound resumes its decay, this time at a new rate determined by the
Release setting.

Attack, Decay and Release Slope
The attack, decay, and release curves each have a slope dot in the middle that you can drag up and down to vary
the curve shape between linear, logarithmic and exponential behavior. This lets you customize each of these curves
to change its feel and snappiness and makes the EG much more versatile.

Tips

When adjusting the EG control points, you can hold down the Shift key to fine-tune
a setting, just like with regular
knobs.

To let a sustain pedal control the EG, you can hook it up to the Hold setting. The
recommended way to do this is via
a MIDI source.

Next: Envelope follower

See Also
Modulation
Drag-and-drop modulation slots
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Envelope follower
The envelope follower modulation source outputs an envelope or transient signal based on the
side-chain input audio level.
Unlike the envelope generator, which produces its own envelope, the
EF tracks the envelope of the trigger signal and
smoothes it out to produce a modulation signal.

To add an envelope follower as a modulation source, click the + button in the modulation section and click New Envelope
Follower.

Initially the EF is shown as a source component button in the interface, showing a graphical representation of the
current settings. For more information on working
with source component buttons, see Modulation.

Click the source component button once to expand the full EF interface:

In the graphical envelope controller you can click and drag the dots to customize
the attack and release times of the EF,
which controls how the signal is smoothed.

Click and hold the audition button to temporarily listen to the external side chain signal
the EF is triggering on.

The mode button toggles between the default Envelope setting and a Transient mode, where the envelope follower will
work as a transient detector, only producing output for short-term bursts of energy in the signal (e.g. drum hits).

Next: MIDI source

See Also
Modulation
Drag-and-drop modulation slots
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MIDI source
The MIDI source is a powerful modulation source if you want more control over FabFilter Twin 3
using a MIDI keyboard or
MIDI controller. Note that you first need to route data from a MIDI
track to Twin 3 in your host.

To add a MIDI source as a modulation source, click the + button in the modulation section and click New MIDI Source.

Initially the MIDI source is shown as a source component button in the interface, showing a graphical representation of
the current settings. For more information on working
with source component buttons, see Modulation.

Click the source component button once to expand the full interface:

The expanded MIDI source interface contains the following controls:

MIDI Input
Normally the MIDI source lets you use MIDI input such as velocity, pitch bend and modulation
wheel to influence any
parameter that can be modulated.

Range
... and when you select Velocity or KB Track, you can set the range of the produced
modulation signal. You can
choose between Negative (-1 ... 0), Centered (-1 ... 1) or Positive (0 ... 1). Other input types use a predefined
range: Pitch Bend always goes from -1 to 1, while Aftertouch, Controller and Mod Wheel produce a signal from 0 to
1.

Controller number
... but when you set the input selection to Controller, it lets you use any MIDI controller
as a modulation source.

Response curve
The response curve can be adjusted to get the desired control over the MIDI source output.
For example, when used
with velocity as MIDI source the linear, exponential, logarithmic,
square, square root or sine curves make great
dynamic differences.

Using a MIDI source is different from MIDI Learn because there is
no direct control of a knob via MIDI but it uses a
modulation slot instead. This way you can add
modulation to an already modulated destination. Or you can use the full
rotation of a knob while
actually modulating a smaller range. This can be a good way to control say, an EG
attack for which
you sometimes want to make small changes with great precision.

Tips

The sustain pedal (CC 64) is applied automatically, so you don't have to route it manually via a MIDI source.

The VST3 version of FabFilter Twin 3 doesn't support per-note aftertouch modulation.

Next: XY controller

See Also
Modulation
Drag-and-drop modulation slots
MIDI learn
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XY controller
The XY controller makes for more tweaking fun. It's a classic, and we didn't dare to leave it
out! It can control two
parameters with one mouse movement. When browsing presets don't forget to
listen to the sound mangling possibilities
provided by these controllers. The XY controller can
also be set to a one-dimensional Slider mode.

To add an XY controller or slider as a modulation source, click the + button in the modulation section and click New XY
Controller
or New Slider.

The new XY controller or slider is now added to the modulation sources in the interface. Note that every source has its own
associated color scheme, which is also used for modulation visualization and indicators in the interface.

You can customize any source's name by double-clicking the label below
its interface. Source names are stored in
presets, A/B and Undo states and will be saved with your session. This is particularly useful for XY controllers and sliders,
to indicate their
purpose in a preset.

In bi-directional mode, the XY controller has two "outputs", so it also has two source drag buttons labeled X and Y. When
using it as a slider, only the Y source drag button is available.

The remove button  at the right top deletes the source, including its associated modulation slots.

At the bottom right of the XY Controller, a drop-down menu gives access to the following options:

The mode switches between the traditional XY mode (two dimensions) or simpler Slider mode (offering only one
dimension).

The range of the XY controller can be set to bipolar (-1 to 1) domain, or to unipolar (0 to 1) behavior.

In slider mode, the current position value of the slider is displayed when you move the mouse over the slider. Double-click
the slider to type a new value directly.

Tips

To reset the XY Controller to its default position, hold down the Ctrl key (Windows)
or Command key (macOS) and
click once.

When you want to adjust only one parameter on one axis, holding Shift will make it
easier to do so while keeping the
other parameter constant.

With MIDI learn, you can set up a hardware MIDI controller to
control the XY controller. So if your MIDI controller
has XY-functionality you can directly
control FabFilter Twin 3 with it.

Next: Arpeggiator

See Also
Support

27



Arpeggiator
Twin 3 is equipped with a full-featured arpeggiator. The arpeggiator automatically
triggers notes on a synchronized tempo,
according to the keys you are holding down.

The following controls are available:

Enable: The enable button, centered in the Rate knob, turns the arpeggiator on or off. When enabled, it will start
playing notes once it has been triggered by
pressing down keys.

Lock: With the Lock button on, the arpeggiator settings won't change when
loading presets.

Rate: The Rate knob sets the arpeggiator speed, ranging from 0.25 to 20 Hz.

Sync: You can also choose to sync the arpeggiator to host tempo at various different
rates. When synched, the rate
knob will turn into an offset knob, to multiply the synched
tempo with a factor from 0.5 to 2.

Retrigger: The Retrigger button (with the MIDI icon) sets how the arpeggiator phase is
synced/started. When off,
the arpeggiator's pattern phase is based on the position on
the DAW's timeline, but when active, the arpeggiator will
restart the cycle on the first
note that is pressed.

Groove: Using the groove slider, you can offset every second note in the produced
rhythm. Using this, you can
easily created dotted/tripplet like patterns. Simply drag the highlighted large middle note symbol to the left or right.

Legato: The legato slider (underneath the large note symbols) sets the note length, from very short to fully legato.

Transpose: By default, the arpeggiator will just play the notes for the keys you
are holding down. But with
transpose settings of 1 or 2 octaves, the arpeggiator additionally
plays the notes one or two octaves higher.

Note Order: The order of how the held notes are sequenced by the arpeggiator. With
the Up and Down options,
notes will be played from lowest to highest or reversed.
To have the notes played from lowest to highest and then
back again, use the Up/Down
option. Otherwise, the arpeggiator can play the notes in the order As Played or in
Random order.

Latch: By default (the Off option), the arpeggiator will only play notes that
are currently held down. By choosing the
Held latch option, the arpeggiator remembers
all notes that have been pressed while any note was held down, e.g.
you can just hold
down one note, and then add others to the pattern one by one. When set to Full latch,
the
arpeggiator will remember any note that you play and will keep playing them even after
you stop holding any notes.

At the top right of the Rate knob, the Presets drop down button
  provides access
to the arpeggiator section presets.

Next: Polyphony, unison and microtuning

See Also
Modulation
Oscillators
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Polyphony, unison and microtuning
FabFilter Twin 3's polyphony, unison and microtuning settings are located in a panel,
available via a button in the bottom
bar:

Polyphony

As you would expect, you can use FabFilter Twin in both Mono or Poly mode. In
Poly mode, the Voices setting
determines the number of voices that can be played
simultaneously. Depending on the complexity of the current patch,
you should set this to a value
that your computer can comfortably handle to avoid glitches while playing.

Twin 3 introduces a new, third polyphony mode: Per Oscillator. In this mode,
every new key you press will use the next
available oscillator. This can lead to unexpected
yet inspiring and creative effects, especially when using multiple wave
forms and scales for the
oscillators: every chord will sound different! Of course this works best if you use all four
oscillators.

Unison

In all modes you can specify the number of unison voices. When using unison, multiple
voices will be activated for each
key that you play. Those voices will be panned from left to
right, and can be slightly detuned relative to each other using
the Spread knob.
Using unison will make you patches sound much more stereo and fat. Try it!

The mono mode uses last-note priority, so the last key pressed
determines the frequency that you hear. When you
release a key, the frequency slides back to
the second-last key pressed, and so on.

The Voices setting always sets the maximum number of simultaneous voices. If Unison is
higher than 1, more than
one voice will be used at a time from the maximum number. For example,
if you have Voices set to 16, and Unison
to 4, you can play four different keys at a time. Of
course, using a high number of voices, unison or not, will cause
high CPU usage.

The Unison Spread parameter is a modulation target. You could, for example, increase the spreading
gradually while
a note is played by modulating it with an envelope
generator.

Microtuning

Twin 3 has extensive support for microtuning, which enables you to use custom
midi-note-to-frequency mappings. By
default, it uses the standard '12-tone equal
temperament' tuning, but this can be customized in three ways:

MTS: First of all, Twin 3 will automatically react to MTS (MIDI Tuning Standard)
information if this supplied by the
DAW. For example, In Logic Pro's project settings,
you can choose a specific tuning or design your own; Twin 3 will
follow these
settings automatically.

MTS-ESP: For DAWs that do not offer custom microtuning, Twin 3 supports
the MTS-ESP
  standard from
Oddsound, which is a system for applying microtuning automatically for all plug-ins in
your DAW that support this
framework. As soon as a master MTS-ESP tuning is active,
Twin 3 will prefer this over a possible normal MTS tuning.

AnaMark tuning files (.tun): Of course, you can also load .tun tuning files to apply
a specific tuning. Click the
tuning button to choose from a list of included tunings, or
click Open Other Tuning to load a custom .tun file. You
can find free tuning file collections for download all over the internet. To clear the loaded tuning and revert back to
MTS or MTS-ESP, click Reset Tuning (only available if a non-standard tuning is loaded).

When a non-standard (i.e. not 12-Tone Equal temperament) tuning is currently active, the
button in the bottom bar will
indicate this with a tuning fork icon.

Next: Full Screen, resizing and scaling

See Also
Overview
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Full Screen mode, resizing and scaling
With just the click of a button, the Twin 3 interface will fill up the whole computer screen
so you can make ultra-precise
adjustments and get the best view on the spectrum analyzer and filter
display. To exit Full Screen mode, just press Escape
or click the Full Screen button again.

Resizing

In addition to Full Screen mode, you can also customize the normal interface size using the
Resize button at the right of
the bottom bar. You can choose between
Small, Medium (the default size),
Large or Extra Large. Once you have selected a
size, it will automatically become the default
size for new plug-in instances.

Scaling

At the bottom of the resize menu, the Scaling submenu lets you increase or decrease the
interface scaling relative to the
system default, e.g. 150% (smaller) or 300% (larger) on
Retina monitors (that have a 200% scaling by default).

When you enable Full Screen mode, the plug-in will automatically choose an appropriate scaling
so that all controls
become a bit larger. The plug-in automatically remembers the chosen scalings
for normal and Full screen mode, and also
per monitor type (Retina / High DPI or regular), so
once you've customized the settings to your preference, you don't have
to worry about it anymore.
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Tips

When using the VST3 plug-in, you can resize the plug-in interface by just dragging the
window edges to any size you
like. Of course you can always go back to one of the predefined
sizes with the resize button.

The large interface options will be greyed out in the Resize button menu
if the current display is too small to support
them, and the same applies to the scaling options.

Next: Output controls

See Also
Overview
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Output controls
The bottom bar contains various output options and settings.

The High Quality button enables oversampling of the internal processing. Non-linearities, oscillator sync or audio rate
modulation in digital audio can cause aliasing effects. Enabling High Quality mode can reduce these aliasing artifacts if
needed, at the cost of using more CPU power.

As soon as you hover the mouse over the output button, at the right end of the bottom bar, a panel with stereo width and
output/pan controls will pop up:

The Width setting sets the stereo spreading of the output signal. By
default, it is at 100% or 'normal stereo', which
means that it does not alter the signal. By
reducing the setting towards 0%, the signal will become more mono. By
increasing it towards
200%, the differences between the left and right channel are enlarged, which makes the sound
more stereo.

Output level/pan
The reading in the output button shows the current output gain and lets you
adjust it from -INF dB to about +10 dB.
To change the gain, you simply drag the input reading in the output button in the bottom bar up and down. For
precise adjustments, or to change the
panning, hover over the output button or click it once to access the input
gain/pan knob.
The gain and pan knobs are also modulation targets.

Notes

Beware that making the signal more stereo can cause some undesirable phase
cancellation.

Both the output level/pan and stereo settings are modulation targets. Volume is commonly
modulated by the
velocity modulation source. The Stereo knob is a
global modulation target, meaning that it affects all voices
simultaneously. When modulating a
global target like Stereo with a per-voice modulation signal such as an envelope
generator, a combined envelope signal is
used instead.

Next: MIDI Learn

See Also
Polyphony, unison and microtuning
Overview

32



MIDI Learn
Controlling FabFilter Twin 3's parameters directly with MIDI is very easy using the MIDI Learn feature. With MIDI Learn,
you can associate any MIDI controller with any parameter.

Click the MIDI Learn button in the bottom bar to enter MIDI Learn mode. The
interface dims and the parameters that can
be controlled are highlighted. Each parameter has a
small text balloon that displays the associated controller number. Now
do the following to
associate a controller number with a parameter:

1. Touch the control of the desired parameter in the interface that you wish to control. A
red square will mark the
chosen parameter.

2. Adjust the slider or knob on your MIDI keyboard or MIDI controller that you want to
associate with that
parameter.

That's it! The parameter will now be controlled with the MIDI controller. You can now go back
to step 1 to associate a
different parameter. Note that there is no warning when you associate a
different knob with a controller number that is
already used. It will just be replaced.

To exit MIDI Learn mode, click the MIDI Learn button again, or click Close at the top of the
interface.

Click the small menu drop-down button next to the MIDI Learn button to access the MIDI
Learn menu:

Clear
This submenu shows all parameter associations and lets you delete individual associations or
clear all associations in
one step.

Revert
Reverts to the last saved MIDI mapping (or the state when the plug-in was started).

Save
Saves the current MIDI mapping so Revert will go back to this state. The current mapping is
automatically saved
when closing the plug-in.

Load Factory Settings
Loads a default MIDI mapping that may be useful.

Next: Undo, redo, A/B switch

See Also
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Overview
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Undo, redo, A/B switch
The Undo and Redo buttons at the top of the FabFilter Twin 3 interface enable you to easily undo changes you made to the
plug-in. With the A/B feature, you can quickly switch between two different states of the plug-in.

The Undo button at the left will undo the last change. Every change to
the plug-in (such as dragging a knob or
selecting a new preset) creates a new state in the
undo history. The Undo button steps back through the history to
restore the previous states
of the plug-in.

The Redo button cancels the last undo command. It steps forward through
the history until you are back at the most
recent plug-in state.

The A/B button switches from A to B and back. Before switching, the current state of
the plug-in is saved, so if you
click this button twice, you are back at the first state. The
button highlights the currently selected state (A or B). In
the example above, the A state is
active.

The Copy button copies the active state to the inactive state. This marks the
current state of the plug-in and allows
you to go back to it easily with the A/B button. After
clicking Copy, the button disables itself to show that both states
are equal, so there is
nothing to copy anymore.

Notes

If the plug-in parameters are changed without using the plug-in interface, for example with
MIDI or automation, no
new undo states are recorded.

The Undo and Redo buttons will disable themselves if there is nothing to undo or redo.

Next: Using on iOS

See Also
Overview
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Using on iOS
FabFilter Twin 3 is available as an AUv3 plug-in for iPad in the App Store. Using Twin 3
on a touch screen is slightly different from using it with a mouse:

To adjust a knob, just touch it and drag up or down. There is no rotational drag
mode like with the mouse.

For fine adjustment, hold down a second finger while you're dragging a knob.

To reset a knob to its default position, simply double-tap it.

To type a new value directly, press and hold on a knob until the on-screen
keyboard appears. Note that the keyboard might obscure the parameter value
display — unfortunately we can't do anything about that because an AUv3 plug-in
cannot control its own position on the screen.

Unlike the regular plug-in, the AUv3 plug-in offers no resizing or full screen mode from
the plug-in interface itself: this must be provided by the host app.

To organize presets on iOS, open the preset browser
and swipe to the left on any preset or subfolder to see options to
delete or edit it. When
editing a preset or folder, you can rename it and move it to another folder.

The Twin 3 app that contains the AUv3 plug-in serves as a stand-alone host that
lets you play the synth with the on-screen
keyboard via the speakers or headphone output. We do recommend to use an AUv3 host
app like Auria, Cubasis, AUM or
GarageBand to take full advantage of Twin 3's features.

View FabFilter iOS plug-ins in the App Store 

Next: Loading presets

See Also
Overview
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Loading presets
The included factory presets give a great overview of what you can do with FabFilter Twin 3.
You can either use the
presets as they are, or tweak them further to create your own unique
sounds.

The preset button shows the name of the current preset. If you have changed the preset by
adjusting one or more
parameters, the name is dimmed to indicate that this is not the
original preset anymore.

Click the preset button to open the preset browser:

The preset browser shows all presets grouped in folders, with the current preset highlighted in
blue.

Preset details

A preset can contain extra information: author, tags and a
description, which is shown in the panel on the right. These
fields are present
in all factory presets and can of course be edited as well: just double
click the author or description. To
add a tag, click the + button.
Double-click a tag to rename it, or hover over the tag and click the x button
to remove it.

Browsing presets

You can browse and select presets in various ways:

Of course, you can simply browse using the mouse. Hover over folders to open them,
and click on a preset to load
it. If you move the mouse outside the browser after selecting
a preset, the browser will close. Otherwise, it will stay
open so you can look around and
try multiple presets, or edit their information.

Within the preset browser, you can use the arrow keys
to navigate, and the Enter key to load a preset and close
the browser. Use the right arrow key
to load a preset without closing the browser. Press the Esc key to
close the
browser without selecting anything.

You can also click the previous/next arrow buttons around the preset button to explore presets
one by one without
opening the preset browser.

... and while the browser is open, use the [ and ] keys to load the
next or previous preset directly.

Searching, filtering and favorites

In the preset browser, you can start typing to search through
the presets, filtering on folder name, preset name or tag.
While typing, the preset
browser automatically filter the current selection and update itself to show the
resulting sub set. If
you've first started browsing by mouse, just click the
Search field and type to start filtering again.

You can also mark presets as favorite, by clicking the star icon next to
the preset name in the preset details panel. Click
the star icon next to the Search field to
show only your favorites.

Preset browser options

Click the Options button  at the left of the search field at
the top to open a menu with extra options:
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When Type To Search is enabled, you can start typing to search, right after you've
clicked the preset button.
Disabling this will always require a click in the Search field
to start searching. This might be handy, for example if
you're working without a MIDI keyboard and
use letters on your computer keyboard to play notes.

When Enable MIDI Program Changes is active, you can load presets via MIDI program change
and bank select
messages. The corresponding bank/program numbers are then shown in front of
the preset name (for example:
(0/65) My Preset). This means that you can load that
preset by first sending a Bank Select message to select bank 0
and then sending a Program Change
message to select program 65.

Important: All the presets in your preset
folder are numbered automatically, starting with bank 0 and program 0.
This way, you are able
to access any of the presets via MIDI. However, this also means that when you add new
presets
to the menu, bank/program numbers of other presets might change. Be aware of this when recording
program changes in a session! We recommend to create a dedicated folder in your presets folder
for your program
changes, and name it with two leading underscores (e.g. "__Programs") to
ensure it's the first folder in your preset
collection and the presets in this folder start with
bank 0 and program 0.

The Default Sound preset is loaded
automatically when FabFilter Twin 3 is started. To change the default settings,
simply
overwrite this preset by clicking Save As Default.

To open a preset outside the presets folder, click
Open Other Preset. This might be useful if someone sends you a
preset by email, for
example.

To change the location where the presets for Twin 3 are stored, choose
Change Preset Folder and select the
desired folder.

If somehow the factory presets are lost or not installed properly, click
Restore Factory Presets to restore them.

If needed, for example after you've manually removed or added files in the folder
while Twin 3 is open, click
Refresh to rescan the preset folder.

Compatibility with Twin 1 an 2
All presets created with Twin 1 and 2 can be loaded in Twin 3. If Twin 1/2 is also installed
on your computer, your Twin
1/2 presets will be accessible via the V1 Preset Folder
submenu in the preset menu. The factory presets for Twin 1 are
also included in the Twin 3
factory presets, so you only need to use the V1 Preset Folder submenu to access presets you
might
have created yourself.

You can read more about compatibility between Twin 1, 2 and Twin 3 in Upgrading to Twin 3. Please take some time to
read it if you are
planning to replace Twin 1 or 2 instances with Twin 3 instances in your songs.

Next: Saving presets

See Also
Overview
Quick Start
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Saving presets
You can easily extend the included presets with new settings to build your own library of
presets for FabFilter Twin 3 that
you can reuse in various projects. This is also a good
way to copy settings across multiple instances of FabFilter Twin 3 in a
session.

To save the current setting as a preset, click the preset button, and then click Save
As. A standard Save dialog will appear.
Type a name for the new preset and click Save
to finish.

In the Save dialog, you can also rename and delete existing presets and create a new folder to
store presets in. New
folders will show up as new categories in the preset menu. (On macOS,
this should be done with the Finder.)

Right-click shortcut menu

You can also right-click on the preset button to open a small menu with shortcuts:

Favorite: Mark the current preset as favorite.

Save: Overwrite the currently loaded preset. You will be asked for
confirmation before saving.

Save As: Just like choosing the 'Save As...' item from the main menu.

See How presets are stored to determine the preset
folder location and learn more about factory presets.

Next: Section presets

See Also
Loading presets
Using FabFilter Twin 3
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Section presets
To make designing sounds for FabFilter Twin 3 easier, you can save section presets for
different sections of the plug-in. In
this way you can, for example, easily re-use certain
settings.

To load and save section presets, click the arrow button  right next to the modulation source name, effect name or in the
arpeggiator interface. This will display a presets menu for that section. FabFilter Twin 3 comes with a selection of ready-
made section presets, but we encourage you to save your own presets to build a custom library of sound building blocks.

Supported sections are:

Effects (Reverb, Delay, Chorus, Phaser and Compressor)

XLFO

Envelope generator

Envelope follower

MIDI source

Arpeggiator

When you add a new modulation source, it loads its Default section preset.
You can customize the initial settings just by
overwriting that preset using the Save dialog.

Section presets are stored in the Application Data folder (Windows) or Application
Support folder (macOS) for the current
user. For example, the full path to the section presets on Windows 10 is C:\Users\
<User>\AppData\Roaming\FabFilter\Twin 3\Component Presets (note that this folder is hidden by default). You cannot
change the section preset paths.

Next: How presets are stored

See Also
Loading presets
Overview
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How presets are stored
Presets for FabFilter Twin 3 are stored in separate files with the .ffp extension (for
FabFilter Preset). All presets reside in
subfolders in the main preset folder. The subfolders
will show up as separate categories in the preset menu. You can also
further divide the
subfolders into categories.

You can manage the preset files just like other files on your computer. The easiest way to do
this is in the Save dialog that
appears if you are saving a preset. The preset menu will
automatically reload itself with the changes when the dialog is
closed.

Furthermore it is very easy to share your newly created presets with other users since
FabFilter presets use the same file
format on both Windows and macOS.

The default location of the main preset folder is Documents/FabFilter/Presets/Twin 3 on both
Windows and macOS. To
change this location, first copy all presets to the desired new location. Click
Options  and Change Preset Folder in the
preset browser and select the new folder.

Note: previously on macOS, presets were stored in ~/Library/Audio/Presets/FabFilter/FabFilter Twin 3.
To determine the
current location of the presets folder, click Options  and Change Preset Folder in the preset browser.

Restoring factory presets

If you have accidentally lost the factory presets, you can easily restore them by clicking
Options  and Restore Factory
Presets in the preset browser. This will install all factory presets again.

Next: Purchasing FabFilter Twin 3
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Purchasing FabFilter Twin 3
Once you have downloaded and installed the evaluation copy of FabFilter Twin 3, you may evaluate it during 30 days.
Every time you start the plug-in, you will see the following
dialog:

While there are still days left, you can click Evaluate to start working with
the plugin. If you want to keep using FabFilter
Twin 3 after the evaluation period, you must buy a copy in the online FabFilter Shop by clicking the Buy Now button in
the
evaluation dialog.

Go to the FabFilter Shop and
purchase FabFilter Twin 3 now 

We accept a wide range of payment methods, like credit cards, PayPal, wire transfer and iDeal.
The FabFilter Shop uses
secure connections and encryption: therefore your personal information is
completely safe.

Within a few minutes after you have purchased your copy, you will receive an email containing
your personal license key.
You use this license key to turn the evaluation copy into a fully
registered version without the evaluation dialog and the
30-day trial restriction. In addition, we will automatically create a FabFilter account  for you (if you don't have one
already). Here, you can access all your license keys at any time.

Note: If the evaluation period has expired but you didn't have the chance to
properly evaluate the plug-in, you can
request a new evaluation period by contacting us at
info@fabfilter.com .

Next: Entering your license key

See Also
Support
License agreement
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Entering your license key
After you have purchased FabFilter Twin 3 in the online FabFilter Shop , you will immediately receive an email
containing
your personal license key. This license key will turn the evaluation version into a
fully registered plug-in.

Start FabFilter Twin 3 and click Enter License in the evaluation dialog,
or click Enter License on the Help menu if the
plug-in is already running.

Copy the license information from the email you have received and paste it into the text
field. Make sure that you
are copying the entire license key including the Product and
Licensee lines! If you are not sure what text to copy,
just copy and paste the whole
email.

After you have entered your license information, you will need to restart the plug-in host, so
make sure you save your
settings if needed. From now on, you will be able to use FabFilter Twin 3 for an unlimited period of time with full support
via email.

Tips

After your purchase, you can always retrieve your license key again by logging into your
personal FabFilter account
. Here you can also keep track of
all your orders and take advantage of great discounts when buying other

FabFilter
plug-ins.

To deauthorize your license key and remove it from the computer, click
Deauthorize on the Help menu. If you
temporarily needed to install your
license on another computer, or if you have transferred your license to someone
else, this is
the way to deinstall your personal license key safely.

Next: Support
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Support
If you need help with problems or questions, and the help file does not provide an answer,
please visit the support pages
on our web site.

Go to FabFilter Support


From here, you have direct access to the customer support forum, very useful tutorial videos
for all FabFilter plug-ins,
online and PDF versions of all our help files, and a section with
extra downloads (such as presets, controller templates,
older plug-in versions).

For sales-related questions and technical support, you can also contact FabFilter directly at
info@fabfilter.com.

Reporting a bug

If you have encountered a bug in FabFilter Twin 3, first of all make sure that you are using the latest version of the plug-
in, which you can find at www.fabfilter.com/download . You can easily check the version of
FabFilter Twin 3 that you are
using by clicking Help > About in the plug-in interface. If the bug is still present in the latest version, please send us an e-
mail at info@fabfilter.com and include as much technical
information as possible: operation system and version, host
software and version, steps to
reproduce the bug, etc. Thanks in advance!

Next: Upgrading to Twin 3

See Also
Overview
About FabFilter

43

https://www.fabfilter.com/support/
mailto:info@fabfilter.com
https://www.fabfilter.com/download/
mailto:info@fabfilter.com


Upgrading to Twin 3
Upgrading from Twin 1 or 2 to Twin 3 is safe and easy: installing Twin 3 will not
replace or delete the previous versions of
the plug-in. All versions will co-exist and can be
used at the same time. This ensures that you can open old songs that use
Twin 1 or 2 without
problems.

Twin 1/2 presets

All presets created with Twin 1 or 2 can be loaded in Twin 3, although they may
sound slightly different due to changes in
the new plug-in version. If you upgraded from
version 1 or 2 to the new version, your original presets will be accessible via
the V1/V2
Preset Folders item in the preset browser. See also Loading presets.

Replacing a Twin 1 or 2 instance by Twin 3

If you are working on a song and want to replace a Twin version 1 or 2 instance with the
new Twin 3, we advise you to do
the following:

First, save the current setting of the original Twin instance as a FabFilter preset
in the Twin 1 or 2 preset folder.

Then, remove the original Twin instance and add Twin 3 in its place.

Finally, load the V1/V2 preset that you just created into Twin 3 via the V1/V2 Preset Folder
submenu in the preset
browser.

Automation

Because the feature set of Twin 3 has changed fundamentally, any automation data that has
been written by a Twin 1 or 2
instance cannot be read correctly by Twin 3.

Next: Manual installation
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Manual installation
When installing FabFilter Twin 3, the installation program will try to copy the plug-in into
the appropriate plug-ins folders,
and in most cases your host will recognize FabFilter Twin 3
automatically. Otherwise, please follow these instructions:

Windows

On Windows, most hosts have their own VST plug-ins folder. So if you are using Windows and
your host does not
recognize FabFilter Twin 3, you need to locate the proper plug-ins folder for
your host first (it is usually shown in the
Preferences or similar dialog). Then, copy the file
FabFilter Twin 3.dll from C:\Program Files\FabFilter\Twin 3 (or
C:\Program Files
(x86)\FabFilter\Twin 3 if you are using a 32-bit host on 64-bit Windows) to the plug-ins
folder that you
have found and restart the host so it can reload all its plug-ins. The VST3, CLAP, and AAX plug-ins are installed in the
standard plug-in folders on your computer.

You can simply uninstall plug-ins or bundles via the Control Panel.

macOS

On macOS, plug-ins are installed in the standard plug-in folders in the system Library
folder. These are the only possible
correct locations:

Audio Units: /Library/Audio/Plug-Ins/Components

VST/VST3: /Library/Audio/Plug-Ins/VST and /Library/Audio/Plug-Ins/VST3

CLAP: /Library/Audio/Plug-Ins/CLAP

AAX: /Library/Application Support/Avid/Audio/Plug-Ins

Note: AU and VST/VST3 plug-ins may also be placed in the user's Library folders under
/Users/<username>/Library/Audio/Plug-Ins.

To uninstall the plug-ins from your Mac, you can just delete the specific FabFilter plug-in
files at the above locations.
Finally, if you really want to delete all data written by our
plug-ins, you can remove the following folders/files as well:

/Users/<username>/Documents/FabFilter/Presets/Twin 3

/Users/<username>/Library/Audio/Presets/FabFilter/FabFilter Twin 3

/Users/<username>/Library/Application Support/FabFilter/Twin 3

/Users/<username>/Library/Preferences/com.fabfilter.Twin.3.plist

Note: Since OS X 10.7 (Lion), the system and user Library folders are marked
as hidden by default. To make them visible
again in Finder, open Terminal (found in
/Applications/Utilities) and enter the following commands:

chflags nohidden /Library
chflags nohidden ~/Library

If you still have problems, contact FabFilter Support .

Next: VST plug-in versions

See Also
Quick start
Support

45

https://www.fabfilter.com/support/


VST plug-in versions
FabFilter Twin 3 is available in both VST 2 and VST 3 formats. They can be installed and used both at the same time. The
VST 3 format offers easy side-chaining, free interface resizing, and
is more CPU-friendly in some cases, but it can only be
used by hosts that support it, for example recent versions of Cubase, Studio One or FL Studio. The VST 2 format is
compatible with a larger variety of hosts.

Next: Using the side chain
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Using the side chain
FabFilter Twin 3 offers the possibility of feeding an external signal
to its side chain, which can be used to trigger Envelope
Generators and is
needed to trigger Envelope Followers. Feeding a signal to a plug-in's side-chain inputs works slightly
different in various hosts. This topic describes the procedure for some of the most popular hosts around: Pro Tools, Studio
One, Ableton Live, Logic Pro and
Cubase.

To explain how it works, we use a scenario with two tracks. The first one
contains Twin 3, which we'll call the main track
from now. The second
track contains the audio that we want to route to Twin 3's external side-chain
input and use as
trigger signal. We'll call this track the side chain
track.

After setting up everything according to the instructions below for your host,
any envelope generators or
envelope
followers that are set to trigger on
the external side chain, will now respond to the side chain signal. You can
check
whether everything is routed correctly: play the audio, open an EG of
EF interface and confirm it's set to trigger to the
external side-chain. Then
use the Audition button to listen to the side-chain signal.

Pro Tools

Open Pro Tools and start a new empty session.

Create and intrument track and an audio track. Add and audio file to the audio track (the side chain track).

Open the Mix window to display the tracks with their Insert slots and Sends slots.

In the first 'Sends' slot of the side chain track, choose 'Bus 1'. The track view for Bus 1 will open: set
its level slider
to 0.0 dB so the bus actually produces audio!

In the first 'Inserts' slot of the main track, choose Instrument > FabFilter
Twin 3.

Open Twin 3's interface and set up an envelope generator
or envelope follower, triggered by the external side chain
signal.

Now, in the 'Key Input' menu of the plug-in interface (just above the FabFilter logo),
choose bus > Bus 1 instead of
the default 'no key input'. Now, the audio from the side chain
track is routed to Twin 3's external side chain input via
Bus 1.

Studio One

Open Studio One and choose 'Create a new song'.

Create and intrument track and an audio track (via Track > Add Tracks...). Add and audio file to the audio track (the
side chain track).

Access the mix window via "Mix" in Studio One’s bottom right corner.

Insert FabFilter Twin 3 on your main track via the '+' button next to the Insert tab.

Open Twin 3's interface and set up an envelope generator
or envelope follower, triggered by the external side chain
signal.

On the side chain track, select Sends > Sidechains > FabFilter Twin 3.

Ableton Live

Open Ableton Live and start with an empty arrangement. We'll use Track 1 as the side chain
track and Track 2 (a
MIDI track) as the main track.

From the folder menu's on at the left top of Ableton Live's interface, drag an audio
clip to the first empty slots of
Track 1.

From the VST (or Audio Units) plug-in menu, also at the left top of Ableton Live's
interface, drag FabFilter Twin 3
onto Track 2, the main track.

In the small device interface for Twin 3 in the bottom Effects section, choose 'Track 1' from the
'Sidechain' drop
down menu.

Open Twin 3's interface and set up an envelope generator
or envelope follower, triggered by the external side chain
signal.

Note: In earlier versions of Ableton Live (< 10.1), setting up sidechaining worked differently,
which is described
here
 .

Logic Pro

Open Logic Pro and create a new empty project via File > New...

Create and intrument track and an audio track. Add and audio file to the audio
track (the side chain track).

Select the main track and add Twin 3 in the instrument slot.

Open Twin 3's interface and set up an envelope generator
or envelope follower, triggered by the external side chain
signal.

In the right top corner of the plug-in interface header, in the 'Side Chain' menu, choose
the side chain track. Now,
the signal from the side chain track is sent to FabFilter
Twin 3's external side-chain input.

Cubase
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Open Cubase and create a new empty project.

Create and intrument track and an audio track. Add and audio file to the audio track (the side chain track).

Open the Mixer. In the main track, click on an empty insert slot and select the VST 3
version of FabFilter Twin 3 in
the Instrument menu (note the VST 3 icon which looks like
///).

Open Twin 3's interface and set up an envelope generator
or envelope follower, triggered by the external side chain
signal.

In the plug-in header, click on the Activate Side-Chain button (right of the R/W buttons)
to enable the external side
chain in Cubase.

At the top of the Mixer, set the output for the side chain track to the side-chain input of
FabFilter Twin 3.

Next: MIDI CC table
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MIDI controller messages
All of FabFilter Twin 3's parameters can easily be controlled using MIDI. Here is a list of
the default MIDI controller
numbers that correspond to the parameters. You can use these
controller numbers to control each parameter with the
sliders on your MIDI keyboard or MIDI
controller.

Not all parameters are linked to a CC number by default. Using the MIDI Learn feature, you can change and add CC
number associations
any way you like.

General

7 - volume
5 - portamento
103 - polyphony

Oscillators

22 - detune 1
20 - scale 1
21 - waveform 1
23 - pulse width 1

28 - detune 2
78 - scale 2
87 - waveform 2
29 - pulse width 2

Filters

74 - frequency 1
71 - peak 1
26 - frequency 2
27 - peak 2

Main EG

73 - attack
75 - decay
79 - sustain
72 - release

XLFO 1

76 - frequency
25 - balance
89 - glide

Notes

You can also consider using a MIDI source, which
provides a different way to use controller change messages.

In Twin 3, CC 64 (sustain pedal) is handled automatically, so you don't have to use a MIDI source to connect this to
the EG Main Hold parameter like in Twin 2.

Next: License agreement
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FabFilter Software License Agreement
This license agreement concerns and describes your rights and the conditions upon which
you may use the FabFilter
software you selected. We advise you to read this entire
agreement. By accepting this agreement or by using FabFilter
software, you agree to all
of these terms. If you do not accept and comply with these terms, you may not use the
FabFilter
software or its features.

Applicability

This license agreement applies to all the FabFilter software, plug-ins and programs you
may use during the Evaluation
period, and/or thereafter subject to an acquired license
key to certain FabFilter software of any version, including any and
all upgrades,
supplements or services, unless other terms come with such versions, upgrades or
supplements.

Licenses

The software will be licensed to the Customer, not sold. With the FabFilter license key,
you will be granted after full
payment the right in perpetuity (meaning that the license
agreement shall not automatically expire) to install, run and use
the software concerned
under certain conditions. These conditions vary subject to the license you acquired.
FabFilter
distinguishes the following licenses:

A Personal License is a named license to the software concerned, granting
access to the software on an unlimited
number of Devices, as long the license is
used by the designated person who acquired the FabFilter license key.
Usage of the
Personal license by someone else but the designated licensee is an infringement of
the rights of
FabFilter. The Customer should at all times protect its license key
from theft and/or abuse.

A Site License is a non-personal license to the FabFilter software concerned,
acquired on the name of an institution
or entity, who is the licensee. A Site
License will grant access to the FabFilter software on a certain maximum
number
of designated Devices, as specified in the license key itself (e.g. "20 seats").
If the Site License is used on
computers/servers for any form of automated
processing, the licensee may not make any plug-in
controls/parameters of the
FabFilter software available to the end users of the FabFilter software, i.e.
only "black
box" processing is allowed.

These FabFilter licenses, whether a Personal or Site License, will give you access to
certain FabFilter software of the
specified major version. The license will include
all future minor updates to the software (e.g. version 2.19 to version
2.20), which
typically include bug fixes or small new features. The license will exclude any
future new major versions of
the products (e.g. version 1.x to version 2.x). To allow
yourself access to such new major version of the software, a new
FabFilter license to
such major version must be acquired.

All FabFilter licenses, both Personal or Site License, give the Customer or end user
the right to install and use the FabFilter
software to the extent it has been developed
and under the conditions herein. Any rights not explicitly granted to you, the
Customer,
remain with FabFilter, including but not limited to the right to alter, reverse engineer,
reverse compile, take
apart, or disassemble the FabFilter software or any of the files
in the distribution.

A Bundle License is Personal or Site License for multiple FabFilter software
products, which gives the Customer or end user
the right to install and use the specific
software products that the bundle (e.g. Total Bundle) contains at the moment of
purchasing
the Bundle License. Any software products or new major software versions added to the
bundle after that date
cannot be claimed as part of the prior acquired Bundle License.
A Bundle License (if not Educational or NFR) can only be
transferred as a whole, using
a License Transfer.

An Upgrade License is a Personal or Site License for a new major version of FabFilter
software. You may only use an
Upgrade License if you have a license for the previous
major version of the same FabFilter software.

Educational (EDU) and NFR licenses

A Personal or Site License can be marked as EDU (Educational) or NFR (Not For Resale),
meaning the following:

A Personal or Site License marked as Educational License is equal to the respective
Personal or Site License, with the
only exception that the Educational License may
not be transferred to a third party.

A Personal or Site License marked as NFR ("Not For Resale"), is typically intended
for journalists that wish to review
the FabFilter software. A License marked as NFR
is equal to the respective Personal or Site License, with the only
exception that
the NFR License may not be transferred to a third party.

Duration and Evaluation

As specified in the specific terms per license, all licenses will be granted for
perpetuity (meaning that the license
agreement shall not automatically expire), as long
as all conditions herein are respected.

The Evaluation period is a period of thirty (30) days commencing on the first day
of using the software concerned and
automatically expiring 30 days thereafter. After
the Evaluation period has expired and no FabFilter license key has been
acquired,
the software will stop working and should be removed from your computer.

In addition to any and all such possibilities that FabFilter may have in accordance
with the law, FabFilter may terminate
without prior notice or warning in case of abuse
of the FabFilter software as well as in case of (personal) bankruptcy.

Support

FabFilter shall give its reasonable commercial efforts to service any major version of any
FabFilter software including email
support. FabFilter is entitled to terminate support for
any major version of any FabFilter software at any time at its sole
discretion.

License Transfer
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A Personal or Site License (not Educational or NFR) may be transferred to a third party. You
will have to buy a License
Transfer to activate the "transfer"-option in your
FabFilter account
 . After this option
has been activated you will be able
to transfer your license to any third party.

Third Party Software

VST is a trademark of Steinberg Media Technologies GmbH. RTAS and AAX are trademarks of Avid
Technology, inc. Audio
Units is a trademark of Apple Computer, inc.

Applicable Law

This license agreement is governed by Dutch law. The courts of Amsterdam are authorized courts
to rule on any dispute
that may arise from this license agreement.

Disclaimer

TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER B.V. SPECIFICALLY DISCLAIMS ALL WARRANTIES,
EXPRESSED
OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. FABFILTER B.V. DOES NOT WARRANT THAT
THE SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THE SOFTWARE WILL OPERATE ERROR-FREE OR
UNINTERRUPTED. TO THE MAXIMUM EXTENT
PERMITTED BY LAW, FABFILTER B.V. SHALL NOT BE LIABLE FOR
ANY DAMAGE A FABFILTER PRODUCT MAY CAUSE OR
DAMAGES THAT MAY ARISE OUT OF THE USE OF A FABFILTER
PRODUCT OR INABILITY TO USE A FABFILTER PRODUCT,
INCLUDING BUT NOT LIMITED TO SPECIAL,
INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES. IN NO EVENT
FABFILTER B.V. WILL BE LIABLE FOR AN
AMOUNT IN EXCESS OF TWO HUNDRED FIFTY EUROS (€ 250,00).
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About FabFilter
Beautiful sound. Fantastic workflow. These are the foundations of FabFilter. We create
powerful audio plug-ins with superb
sound quality and innovative interfaces.

A unique perspective

At FabFilter, we make the best possible tools for music production and audio processing. To
achieve this, we continually
rethink and challenge industry standards: we've never been afraid of
reinventing the wheel. Considering every little detail,
we tune our algorithms and interfaces
until they sound perfect, look amazing and feel great to work with.

It's the sound that counts

Above everything else, you need superb sound quality. That's why we put a lot of effort into
developing unique audio
processing algorithms, ranging from our famous resonating filters to
transparent high-end EQ and dynamics processing.

Innovative interfaces, great design

Every FabFilter plug-in has an easy-to-use, well-designed interface aimed at providing
unsurpassed workflow. Our plug-ins
focus on the task you're performing at that specific moment:
they expose the features you need, when you need them.
And because of our special attention to
design, you'll be delighted every time you open a FabFilter plug-in.

Don't take our word for it

We always set the highest standard for sound quality, usability and design to make truly great
products that raise the bar
on what audio software can do. That's why we're very happy with the
praise we've received from users and press alike:

"In the decade since the release of its first plug-in, One, FabFilter has made an indelible
mark on the music
production landscape." — Computer Music magazine

"While many other software developers are busy trying to model hardware, FabFilter is
leaving them in the dust
by being visionaries and reaching into the future. FabFilter stuff is
just on another level." — Jeff Sanders

"FabFilter has an enviable reputation for making easy-to-use, powerful tools." — Music Tech
magazine

FabFilter was founded in 2002 by Frederik Slijkerman and Floris Klinkert, and is based in
Amsterdam, The Netherlands.
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